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by Tonya Limberg ©2008, MS, Biomedical Visualization, University of lllinois at Chicago

Osirix is a freeware program available to the public
on the Apple Inc. Website. Biomedical Visualizers can
use this software to visualize anatomical data sets and
extract visual information for reference.

This tutorial is directed to the novice user for visualiza-
tion needs. I found that the resources I came across for
Osirix were primarily for the radiologist or computer
programer. I will share with you my personal experi-

ences learning this program and what I found useful
for Biomedical Visualizers.

I have included Terms you can use throughout the
tutorial and there is also a list of terms at the end of the
tutorial for your reference.

Any questions or comments can be directed to tlim
berg@wi.rr.com. I hope you find this tutorial useful.
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OsiriX Installer

Getting started

To get started you can download the Osirix program
at: www.apple.com/downloads/macosx/imaging_3d/
osirix.html

You will need to unzip the program by double clicking
on the desktop icon. Then double click the Osirix
Installer icon and it automatically installs to the loca-
tion you designate.

Public image data sets can be downloaded to your
desktop at: pubimage.hcuge.ch:8080/

The DICOM files can be used in Osirix and are created
from CT, MRI and PET medical equipment. The file
sizes are listed for your reference.

OsiriXasa
resource

TERMS YOU CAN USE

DICOM
File extension - .dcm
Digital Imaging and Com-

munications in Medicine.

The DICOM file stan-
dard is used in image and
patient data from CT, MRI
and PET medical imaging
equipment.

CT

Computed Tomography
Image sections are created
from a 2D Xray moving
around a single axis. They
form a 3D image of inter-
nal anatomy.

MRI

Magnetic Resonance
Imaging

Magnetic field is created
around anatomical struc-
tures creating an image.

PET

Positron Emission
Tomography

3D image of metabolic
activity is created using
gamma rays that interact
with a metabolically active
molecule.



Window 1
Database window

Window 2
Viewer window
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Window 3

3D volume rendering

Navigation

Osirix navigation is accomplished by using three main
windows.

The first window you will see is the Database Window.
This is where data sets are imported.

The second window is the Viewer Window; it is
opened by selecting the 2D-3D viewer button in the

Osirix

first window’s toolbar. This window allows for viewing
and manipulation of 2D (two-dimensional) data sets.

The third window is specific to the type of 3D (Three-
dimensional) rendering tool you select under the
2D/3D button. The window 3D Volume Rendering is
shown here. This window allows for viewing and ma-
nipulation of 3D data sets.
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Osirix

Database Window (com+D)
import data sets

Viewer Window
view and manipulate
2D data sets

3D Window
view and manipulate
3D data sets



Navigation

The Database window has a main toolbar, patient and
study list, image thumbnails and a preview pane. This
organization window lists the imported data sets and
allows you to preview the images. Images are imported
by clicking on the Import icon. Other toolbar icons are
described in the sidebar on the right.

The toolbar can be customized by selecting Custom-
ize Toolbar from the Format menu. Then simply drag
and drop the icons in or out of the toolbar. Three icons
I would recommend removing are Query, Send and
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Preview
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Window 1 Database window
Report, since they pertain to

working in a PACS (Picture @ @ ﬁ;\
Archiving and Communica- QUSRS [ESendr [Report
tion System workstation). A PACS workstation is used
by radiologists to coordinate image workflows from
CT, MRI and PET scanners.

To view a specific set of images select the name of the
series you would like to open in the patient and study
list. Then click on the 2D-3D viewer button in the
toolbar. This will open the Viewer Window.
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|E::j Import
13 ‘I import data
Import
CD-Rom
o y  import

CD-Bom from cd

- Export

ﬂ export data

@ Anonymize

oo remove ID
Anonymize
iPod
E| export to iPod
iPod

2D-3D Viewer
a-mviesss  Open window

ﬁ 4D Viewer
sync PET and

CT scans
? Burn

burn cd
Burn

Albums &

:¢: Sources
| create data sets

PACS
Picture Archiving &
Communication System

Used to coordinate
workflow of scans
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Navigation

The Viewer window displays data sets from a select
series and allows you to manipulate 2D images. The
Viewer window has a main toolbar, image thumbnails
and a preview pane. If you click on the Database tool
the Viewer window will close.

Move the mouse in a horizontal direction to change
contrast and a vertical direction to change intensity

Osirix

Window 2 Viewer window

when using the Contrast and Adjustment tool.

Contrast is also referred to as Window Length (WL)
and intensity as Window Width (WW). The tool WL
& WW has some preset contrast and intensity settings

in the pulldown menu.

The CLUT (Color Look Up Tables) tool is used to as-

sign color to the images.
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Database
[ return to window
’ Tile
@ tile view

Series

@| o | previous/next
Patient
&Jlﬁ] p?et/eigus/next

Contrast
@ Adjustment
contrast & intensity
| Move and Pan

|
| i command key

Zoom
| b | shift key

Rotate
H G | horizontally move

Scroll

|

Hg| through image set
Length

measure distance

 Default WLEW = 1

WL & WW
preset contrast and intensity

No CLUT -'1

CLUT
Color Look Up Tables
assign color
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Navigation

Two export features in the viewer window are Movie
Export and Print. The rest of the tools featured on this
page use 3D representation in the 2D viewer window.

The Orientation tool allows the flexibility of chang-
ing between axial, coronal and sagittal views in the
preview window. The 3D tool displays data in 3D in a
separate window.

Osirix

Window 2 Viewer window

The Thick Slab tool increases the original thin slabs to
a thicker viewing to increase viewing depth.

Browse gives a dynamic display of static images. The
rate at which Browse moves through the stack is de-
termined by moving the Rate slider to the right of the
Browse tool.

Propagate and Sync apply changes throughout the stack.

777
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Orientation
plane of reference

Mode:  Inactive s

20 =
Thick Slab

change slab thickness

: Movie Export
@ create a

Quicktime movie

Browse
gi display cine
images
™ Loop 10.0im/s
,—G———

Rate
speed of browse button

3D Panel
ﬂ data in 3D
Print

ﬁ print image

Sync
# | applies changes
to all images

Propagate
ROI to all
images in stack
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Navigation Window 2 Viewer window " [——

Axial, coronal, sagittal planes

The 3D viewer is accessed by clicking on the 2D/3D An Oblique MPR of the heart allows the heart to be
viewer button pulldown and making a selection. There represented in a 2D image at the angle it is positioned

are two sections to the pulldown menu. in the body. Using a Curved MPR creates a 2D repre-

sentation of a dentagram. The Orthogonal MPR allows
The first section uses 3D data to create a 2D image you to interact with a given point on the body in axial,
with MPR (Mulitplanar Reformatting). There are coronal and sagittal views simultaneously.

oblique, curved and orthogonal MPR options.

MPR Multiplanar Reformatting
slicing through data in a new way
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Navigation

The second section of the 2D/3D viewer button pull-
down menu creates 3D images in MIP (Maximum In-
tensity Projection), 3D Volume Rendering, 3D Surface
Rendering and 3D Endoscopy.

The 3D MIP selection displays contrast enhanced im-
ages to define vasculature. The 3D Volume Rendering
selection can have different colors and transparencies

Osirix

Window 2 Viewer window

assigned to different tissue types. In this way bone,
muscle and skin can be defined.

The 3D Surface Rendering selection creates surface

triangles much the same way 3D design or CAD pro-
grams do. The 3D Endoscopy selection allows you to
navigate through a lumen to view internal structures.

asd

MIP
Maximum Intensity Projection
high contrast for 3D object

E 3D MIP

Contrast (vasculature)

i
osirix-viewer.com/Snapshots.html

ﬂ 3D Volume Rendering

Tissue intensity values

osirix-viewer.com/Snapshots.html

% 3D Surface Rendering

Rendering
volume for
3D programs

osirix-viewer.com/Snapshots.html

3D Endoscopy

. Navigate
il through
[ lumen

osirix-viewer.com/Snapshots.html
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Navigation

The third window appears once a selection has been
made from the 2D/3D viewer button pulldown menu.

This windows is titled according to the selection chosen.

The 3D window has a main toolbar and preview pane.

The Contrast, Move and Pan, Zoom, Rotate, Length,
WL & WW and CLUT tools are the same as in the
Viewer window. Note that color can be manipulated in
the histogram when making a bit selection at the bot-
tom of the CLUT pull-down menu.
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Window 3 3D Volume Rendering

Preset opacities are available in the Opacity tool. The
Manipulate tool moves the object around it’s center of
gravity. The camera position can be changed with the
Angle of View tool. A Tag Reference Point tool is used
to point out a specific feature. The Sculpt 3D Object
tool acts as a scissors. Material is outlined by clicking
points to form a shape to be deleted. Click on a bone
with the Bone Removal tool, and it will remove it. De-
tail can be adjusted in the Fine /Course slider.
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Contrast
Adjustment
contrast & intensity

Move and Pan
command key

Zoom
shift key

Rotate
horizontally move

Manipulate
around center
of gravity
Angle of View
camera position

O] [Z)[e] [ [e] L) [+] &

‘ Length
measure distance

Tag Reference Points
specific feature

Sculpt 3D Object
scissors cut out

][R

A

:gc Bone Removal
removes bone

WL/WW:  Other -]
preset contrast and intensity

CLUT: VR Muscles-Bones --]

Color Look Up Tables
assign color

Opacity: Logarithmic Table --]

Opacity preset opacities

Fine Coarse Detail
- v ne
course
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Navigation

Other tools for the 3D Volume Rendering window
include the Best Rendering tool. This tool renders the
image at it’s best resolution.

The Crop Volume tool has a wire frame that creates a
box around the object to crop it. The Orientation tool
toggles the visibility of the orientation box in the up-

per right corner of the preview window.
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Window 3 3D Volume Rendering

The DICOM file tool exports DICOM files.

An animated movie can be created with the Fly Thru
tool that can be inserted into Microsoft PowerPoint.

Ray cast and 3D texture can be applied with the

Engine tool pulldown menu. Advanced tools in Per-
spective and Shading are also available.
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- Best Rendering
Ej resolution

5 Crop Volume
@ frame to crop

Orientation
@ toggles box in
corner on/off

DICOM file
export DICOM

animated movie

— Fly Thru
i

- Engine
| W | Ray cast
3D texture

v B
[
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—
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B0 Texture IGRA
Bay Cast (Best), 30 Textare (Preview)

A

i " Ray Cast {CPUY

®) Parallel Perspective
() Parspective | advanced
() Endoscopy

| E Shading  Ambient: n.f'
| —_— Diffuse: 0.9
Edit |

Specular :0,3-15.0
Shading advanced
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Sources for data

There are two types of sources for Osirix image data:
public and private. Many public offerings are available
downloads on the internet. These include the previous-

Index of ftpyiftp.erlwustlLedu/pub/dicom/
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sourceforge.net/project/showfiles.php?group_
id=107249&package_id=165209&release_
id=360395

nlm.nih.gov/research/visible/visible_gallery.html

Database window import

ly mentioned Osirix website and other public sources  clients.

listed in the sidebar at the right.

It is important to ensure that patient data is provided

The public data is de-identified. It has been stripped of ~ without identity or ID markers attached.

any patient identification.

The second source is privately supplied data. It is now
possible with Osirix to request DICOM files from CT,
MRI or PET scanners for reference when working with

OSiriXasa
[esource

DATA WEBSITES
pubimage.hcuge.ch:8080/x

sourceforge.net/proj
ect/showfiles.php?group_
id=107249&package_
id=165209&release_
id=360395

www.nlm.nih.gov/re
search/visible/visible_gal
lery.html

www.barre.nom.fr/
medical/samples/

ftp://ftp.erl.wustl.edu/pub/
dicom/

ftp://ftp.nlm.nih.gov/vis
ible/bitmaps/color24/



DICOM
TIFF

AVI

MPEG

Database window import

File formats

Osirix accepts many file formats. These file formats
include DICOM, TIFE JPEG, PDE AVI, MPEG and
Quicktime.

TIFF (.tiff) or Tagged Image File Format stores image
data in tags. It does not lose file data when it is com-
pressed and therefore is referred to as lossless com-
pression. The TIFF has advanced pixel data types for
scientific imaging. JPEG (.jpg) or Joint Photographic
Experts Group uses lossy compression and may lose
data if saved multiple times. There is a 12-bit jpeg for
medical systems. PDF (.pdf) or Portable Document

Format is independent of software, hardware or OS. It
can contain text, fonts & images. AVI (.avi) or Audio
Video Interleave contains audio & video data. The
MPEG (.mpg) or Moving Picture Experts Group con-
tains video & audio data and has various compression
formats. Quicktime (.mov) is a video, media, sound,
text, animation and image interactive file format.

The file formats were tested with Osirix and all import-

ed to confirm compatibility. No file formats have been
found at this time that need to be converted.

OSiriXasa
[esource

TERMS YOU CAN USE

TIFF (.tiff)

Tagged Image File Format.
Stores image data in tags.
Lossless compression.
Advanced pixel data types
for scientific imaging.

JPEG (.jpg)

Joint Photographic
Experts Group.

Lossy compression.
12-bit jpeg for medical
systems

PDF (.pdf)

Portable Document Format
Independent of software,
hardware or OS.

Text, fonts & images.

AVI (.avi)
Audio Video Interleave.
Audio & video data.

MPEG (.mpg)
Moving Picture
Experts Group.

Video & audio data.
Compression formats.

Quicktime (.mov)
Video, media, sound text,
animation, interactive
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iPod connection in iTunes

Images can be exported from Osirix by numerous
means.

DICOM images can be exported with the Export tool.
Selecting Export under the File menu allows you to
export to Quicktime, jpeg, raw, tiff, DICOM, email and

iphoto.

The Burn tool burns files to a CD with the Osirix
viewer included so others can view the files.

Images can be exported to an iPod to be stored or
viewed. To export images to store, connect the iPod
to the computer and click on the iPod tool. To export
images to view, select export under the file menu and
select iPhoto. Create an album in iPhoto for Osirix
images then open iTunes. Select the iPod and click on
the Images tab. You can select the Osirix folder to be
viewed. In the future you will be able to store Osirix
images on your iPhone.

I would recommend storing files on a CD or iPod to re-
duce the amount of space taken up on your hard drive.

OSiriXasa
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TOOLS YOU CAN USE

Export
export data

iPod
export to iPod

== Burn
—-Q burn cd

Export to Quicktime 385
Export to Quicktime VR

Export to JPEG 4+ #E
Export to RAW
Export to TIFF 038F

Export to DICOM
Export to Email
Export to iPhoto

File Menu - Export
format selection
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Fly thru dialogue box.
Steps and Movie tab.

Export 3D

DICOM, Quicktime movies, Quicktime VR movies
and Fly Thrus can be exported in the 3D window.

Click on the DICOM tool to export a new set of DI-
COM images to a desired location.

The Quicktime tool generates a 180 or 360 degree
movie. The Quicktime VR tool creates an interactive

movie that you can rotate in real time.

The Fly Thru tool allows you to create a dynamic image
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Osirix

sequence. Click on the fly thru tool and a dialogue box
allows you to add or delete images by clicking on the
Plus or Minus signs. Change the angle of the object,
zoom in and out, and affect the contrast and intensity
levels while adding these to the fly thru. In order to
view the movie click on the Movie tab in the dialogue
box. Click on Compute and under the Frame section
play the movie. If the movie jumps, try adding extra
transition images when creating something like an
intense zoom. To export the movie click Save in the
Movie tab to export a Quicktime movie.

asd

DICOM File
export DICOM

Movie Export

@ create a

Quicktime movie

VR Movie Export
Ei ! .i' create interactive

Quicktime movie

: Fly Thru
_'_'.}- r animated movie
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T@Ch mq ye 2D and 3D Window Vessel Separation

Vessels in angiograms can be separated out using the and the image mask will be subtracted from all of the

subtraction mask. dynamic images post-injection. The mask can be turned
On and Off in the upper left of the subtraction button.

A Subtraction Mask can be used with the Browse tool

to preserve areas of the image that move over time and  Filters can be applied to enhance the image for further

remove those areas that do not. In this way the vessels  separation. These can be found under the 2D Viewer

will be separated from the rest of the image. menu. Select Convolution Filters to make your filter
choice.

Add the Subtraction tool to the toolbar by accessing

Customize Toolbar from the Format menu. Select the 2D subtracted vessels can be visualized in 3D when

mask image that was created pre-injection and click using MIP. The 3D MIP selection displays contrast

Mask in the subtraction tool. Then click the browse tool ~enhanced images to define vasculature and organs.

asd

TERMS YOU CAN USE

Angiogram
Static or dynamic.

Used to visualize the lumen

of vessels or organs.
Contrast agent injected
shows up on x-ray.

TOOLS YOU CAN USE

Subtraction Mask
Separate dynamic portion
of image from the rest.

Convolution Filters
Enhance image for further
separation.
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Technique

ROI stands for Region Of Interest. Tools in the ROI
pulldown menu will draw Ovals, Lines, Rectangles and
Polygons. Text and Arrow annotations can be made

on the image. Length and Angle measurement tools
are available. Points can be added and a Brush used to

select areas.

The Repulsor tool manipulates the ROI already cre-
ated, and the Selector tool makes multiple selections.
By double clicking on any region of interest a dialogue

Osirix

2D Viewer window ROI

box appears that allows you to change line weight,
color, grayscale and text size. The ROI can be turned

on or off for any file.

The Propagate tool allows you to apply the ROI to vari-

ous slices.

Region Growing allows you to select a point and it will

grow the area to include similar pixel density ranges.
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ROI
Region Of Interest
emphasized area on image
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Osirix — grow region tool

Technique

Two volume rendering techniques for separating organs
are shown here. The grow region technique and the crop
technique.

An organ that has a significant density difference such
as the lung can be separated with the grow region. Select
the Grow Region tool under the ROI menu. Select 3D
Growing Region in the dialog box so you are applying it
to the whole series. Next to Algorithm select Threshold
(interval) to select the simplest method. Click on the
lung area and a transparent ROI selection will be made.
Different points on the image and different threshold
values can be selected to see varying results. Then click
Compute on the dialog box to create an ROI for the
whole series.

To include the vessel lumens click on the ROI Menu and
select Brush ROI Filter and then Closing. Use 10 pixels
in the radius value requested.

Osirix — crop volume tool

3D Volume Rendering Organ Separation

To remove all of the pixels not in the ROI go to the
ROI Menu and select Set Pixel Values To. A parameters
dialogue box will appear. Set all pixels outside the ROI
to -1024. This will separate the lungs from the rest of
the data.

A heart rendered in 3D Volume rendering can be
separated from the surrounding tissue by using the crop
technique. The green dots of the Crop tool represent
each plane. The planes can be moved in and out to crop
the object. Then the Sculpt 3D Object tool can be used
to select and delete areas to be removed. A superior
view is a good way to separate the anterior ribs from
the heart.

Transparency can also be affected with the Contrast

tool. Increase contrast to visualize bone and lower con-
trast to visualize soft tissue.
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Osirix two surface renderings

Osirix one surface rendering

T@Ch mq ye 3D Surface Rendering Separation

After selecting 3D Surface rendering a dialogue box
appears. This box has Predefined Pixel Values for the
first and second surfaces. A transparency can be added
to visualize the surface beneath. The Resolution and
Smooth Iterations can be adjusted with trial and error
to better represent the form of the object that is being
created with triangles on it’s surface.

A Ray-trace rendering effect is generated on the sur-
face using these parameters to apply shading, lighting,
color and transparency to the object.

A 3D surface model can be exported that is compatible
with graphic modeling programs such as 3D Studio
Max and Maya. The Export 3D-SR tool exports five

file formats. They are Renderman, VRML, Inventor,
Wavefront and STL.

asd

Ray-trace

simulates the effects of light
shading, lighting, color and
transparency

Renderman (.rib)
RenderMan

interface between rendering
and modeling programs

VRML (.vrml)

Virtual Reality Modeling
Language

represent 3D vector graphics

Inventor (.iv)
code to display 3D objects

Wavefront (.obj)
3D object file

STL (.stl)

representing solid models

Caneel | i)

Dialogue Box 3D Surface
define pixel value
resolution and iterations
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ﬁ 4D Viewer
sync PET and

4D Viewer ~
CT scans

Rate: —(I — |1¥—~| =46 imjs
Pos: —————— | Play

40 Player

4D Player
Plays dynamic sequence

E 3D Volume Rendering

tissue intensity values

4D movie from cardiac CT osirix-viewer.com/Snapshots.html 4D movie from cardiac CT osirix-viewer.com/Snapshots.html

Dynamic Gated Cardiac
continuous portrayal of the
heart over time

T@Chmque 2D and 3D Window Beating heart

Dynamic Gated Cardiac CT, MRI and PET images can ~ Once in the Viewer window select 3D Volume render-

be visualized in Osirix as a beating heart. ing in the 2D/3D tool.
Select all of the image thumbnails in the Database Customize the toolbar so the 4D Player tool is in the
window and click on the 4D tool. toolbar. This 4D player tool has a Play button to acti-

vate the beating heart.
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Resources

This tutorial was produced to improve the novice users By providing terminology, navigation and techniques
understanding of Osirix as a resource. that pertain to the Biomedical Visualization user, I
hope to promote the use of Osirix as a resource.

Other resources that were used in creating this tutorial
are listed in the sidebar to the right for your reference.

OsiriXasa

Wikipedia
http://en.wikibooks.org/
wiki/Online_Osirix_Docu
mentation

Osirix the Pocket Guide
osirix-viewer.com/Learn
ing html

Osirix tutorial - Apple, Inc.
seminars.apple.com/
seminarsonline/osirixintro/
apple/index.html?s=300

Osirix Home Page
osirix-viewer.com/index.
html

Osirix Discussion Groups
tech.groups.yahoo.com/
group/osirix/

Email Project Lead
Co to Home Page
OsiriX Discussion Group

User Manual
Online Documentation

Help Menu in Osirix



TERMS YOU CAN USE

3D window (p. 4)
view and manipulate
3D data sets

Angiogram (p. 16)

Static or dynamic.

Used to visualize the lumen of
vessels or organs.

Contrast agent injected shows

up on x-ray.

AVI (.avi) (p. 13)
Audio Video Interleave.
Audio & video data.

CT (p. 3)

Computed Tomography

Image sections are created
from a 2D Xray moving around
a single axis. They form a 3D
image of internal anatomy.

Database window (p. 4)
import data sets (com+D)

DICOM (p. 3)

File extension - .dcm

Digital Imaging and Commu-
nications in Medicine.

The DICOM file standard is
used in image and patient data
from CT, MRI and PET medi-
cal imaging equipment.

Dynamic gated cardiac (p. 20)
continuous portrayal of the
heart over time

Inventor (.iv) (p. 19)
code to display 3D objects

JPEG (jpg) (p. 13)

Joint Photographic

Experts Group.

Lossy compression.

12-bit jpeg for medical systems

MIP (p. 9)
Maximum

Intensity Projection
high contrast for 3D object

MPEG (.mpg) (p. 13)

Moving Picture

Experts Group.

Video & audio data.
Compression formats.

MPR (p. 8)

Multiplanar Reformatting
slicing through data in a new way

MRI (p. 3)

Magnetic Resonance
Imaging

Magnetic field is created
around anatomical structures
creating an image.

PACS (p. 5)

Picture Archiving &
Communication System
Used to coordinate
workflow of scans

PDF (.pdf) (p. 13)

Portable Document Format
Independent of software, hard-
ware or OS.

Text, fonts & images

PET (p. 3)

Positron Emission
Tomography

3D image of metabolic activity
is created using gamma rays
that interact with a metaboli-
cally active molecule.

Quicktime (.mov) (p. 13)
Video, media, sound text, ani-
mation, interactive

Ray-trace (p. 19)

simulates the effects of light
shading, lighting, color and
transparency

Renderman (.rib) (p. 19)
RenderMan

interface between rendering
and modeling programs

OsiriXasa

ROI (p. 17)
Region Of Interest
emphasized area on image

STL (.stl) (p. 19)
representing solid models

TIFF (.tiff) (p. 13)

Tagged Image File Format.
Stores image data in tags.
Lossless compression.
Advanced pixel data types for
scientific imaging.

Viewer window (p. 4)
view and manipulate
2D data sets

VRML (.vrml) (p. 19)
Virtual Reality Modeling
Language

represent 3D vector graphics

Wavefront (.obj) (p. 19)
3D object file

Index

This list of terms is offered to aid in your and information on the discussion topic.

understanding of Osirix.

Page numbers are given for each term. Look for
sidebars on the accompanying pages for terms



TOOLS YOU CAN USE

2D-3D Viewer (p. 5)
open viewer window

2D/3D (p. 8)
open 3D window

2D MPR (p. 8)
oblique planes across
data

2D Curved MPR (p. 8)
curved planes across
data

2D Orthagonal MPR
(p-8)

axial, coronal, sagittal
planes

3D Endoscopy (p. 9)
navigate through lumen

3D MIP (p. 9)
Maximum Intensity
Projection

Contrast (vasculature)

3D panel (p. 7)
data in 3D

3D Surface Rendering

(p.9)
rendering volume for
3D programs

3D Volume Rendering
(p. 9, 20)
tissue intensity values

4D Player (p. 20)
Plays dynamic sequence

4D Viewer (p. 5, 20)
sync PET and CT scans

Albums & Sources

(p-5)
create data sets

Angle of View (p. 10)
camera position

Anonymize (p. 5)
remove ID

Best rendering (p. 11)
resolution

Bone removal (p. 10)
removes bone

Browse (p. 7)
display cine
images

Burn (p. 5, 14)
burn cd

CD-Rom (p. 5)
import
from cd

CLUT (p. 6, 10)
Color Look Up Tables
assign color

Contrast (p. 6, 10, 18)
Adjustment
contrast & intensity

Convolution filters

(p. 16)
Enhance image for
further separation.

Crop volume
(p. 11, 18)
frame to crop

Database (p. 6)
return to window

Detail (p. 10)
fine/course

Dialogue box 3D

Surface (p. 19)
define pixel value
resolution and
iterations

DICOM file (p. 11, 15)
export DICOM

Engine (p. 11)
Ray cast 3D texture

Export (p. 5, 14)
export data

File menu - export

(p- 14)
format selection

Fly Thru (p. 11, 15)
animated movie

Grow Region

(p. 17,18)

similar pixel densities
added to pixel selected

iPod (p. 5, 14)
export to iPod

Import (p. 5)
import data

Length (p. 6, 10)
measure distance

Manipulate (p. 10)
around center of gravity

Move and Pan (p. 6, 10)
command key

Movie export

(p. 7, 15)
create a
Quicktime movie

Opacity (p. 10)
preset opacities

Orientation (p. 7, 11)
plane of reference

Patient (p. 6)
previous/next

Perspective (p. 11)
advanced

Print (p. 7)
print image

Propagate (p. 7, 17)
ROI to all
images in stack

Rate (p. 7)
speed of browse button

Rotate (p. 6, 10)
horizontally move

Scroll (p. 6)
through image set

Sculpt 3D object
(p. 10, 18)
scissors cut out

Series (p. 6)

previous/next

Shading (p. 11)
advanced

asd

Subtraction mask

(p- 16)

Separate dynamic
portion of image
from the rest.

Sync (p. 7)
applies changes to
all images

Tag reference points

(p- 10)
specific feature

Thick slab (p. 7)
change slab thickness

Tile (p. 6) tile view

VR Movie export
(p- 15)

create interactive
Quicktime movie

WL & WW (p. 6, 10)
preset contrast and
intensity

Zoom (p. 6, 10)
shift key

Index

This list of tools is offered to aid in your un-
derstanding of Osirix.

Page numbers are given for each tool. Look
for sidebars on the accompanying pages for

tools and information on the discussion topic.



